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Part I: Biomechanics 
 

Objectives 

• Familiarize the students with parameters that concern human body movements. 

• Learn how to measure and analyze biomechanical measurements. 

• Perform biomechanical measurements in different postures and activities. 

 

Preface 

The human body is like a machine where the different components (e.g. bones, muscles, ligaments and 

tendons) are mechanically connected. The musculoskeletal system is subjected to mechanical forces 

created by the earth's gravity and body movements. These forces largely determine tissue development, 

growth and health through an intricate feed-back system where cells within the tissue can sense their 

mechanical environment and respond with biochemical signals. These signals in turn alter the 

tissue composition and structure, and thus the tissue's biomechanical behavior.  

Biomechanics uses laws of physics and engineering concepts to describe motion undergone by the various 

body segments and the forces acting on these body parts during normal daily activities. It also involves the 

application of the principles, laws, and methods of mechanics to develop and improve medical diagnostics, 

biomedical devices, and biomechanical models. In addition, Biomechanics permeates a wide range of 

fields that affect everyday lives. Examples include designing work tasks to reduce physical stresses, 

designing surgical devices to withstand loads and developing advanced prostheses and surgical procedures 

to ensure proper physiological function.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Experiment #1 

Biomechanical Analysis 

Anthropometry and 

Goniometry 

Objectives 
 

1. To learn how to use the measuring instruments. 

2. To learn how to perform and describe reference points to take anthropometric and range of motion 

measurements. 

3. To express anthropometric measures in percentiles of any similar population for the measured data. 

4. To become familiar with goniometry system. 

5. To study the range of motion for selected body joints. 

 

Theory 

Anatomical Body Planes 

An anatomical plane is a hypothetical plane used to transect the human body, in order to 

describe the location of structures or the direction of movements. In human anatomy, three 

principal planes are used: 

• The sagittal plane or median plane (longitudinal, anteroposterior) is a plane parallel to    

the sagittal suture. It divides the body into left and right. 

• The coronal plane or frontal plane (vertical) divides the body into dorsal and ventral (back 

and front, or posterior and anterior) portions. 

• The transverse plane or axial plane (lateral, horizontal) divides the body into cranial and 

caudal (head and tail) portions. 

There are two primary types of dimensions: 
 

1. Static dimension: taken when the body is in fixed (static) positions (Shoulder height). 

2. Dynamic dimensions: taken under conditions in which the body is engaged in some physical 

activity, such as practical limit of arm reach. 

 

Anthropometry 

Anthropometry simply means "measurement of people". The word is derived from the Greek 

‘Anthropos’ meaning human, and ‘metrein’ meaning measure. It is the science that deals with the 

measurement of size, mass, shape and inertial properties of the human body. Anthropometry is empirical 

in nature and has developed quantitative methods to measure various physical dimensions and other 

properties of specific populations. The results are statistical data describing human size, mass, and form. 

Anthropometric data are fundamental to occupational biomechanics and without such data 

biomechanical models that predict human reach, force and space requirements cannot be developed. 

When performing a biomechanical analysis of a person, the human body is considered to be a system of 

mechanical links with each link of known physical size and form. Anthropometry defines theses size  

and form properties as the followings: 

 

 



• Body-Segment Link Length 

• Body-Segment Volume and Weight 

• Body-Segment Link Locations of Center of Mass 

• Body-Segment Inertial Property 

Standard anthropometric postures for standing and sitting: 
For the seated person measurements are taken relative to the horizontal and vertical reference 

planes that represent the seat surface and back of the seat. The point where these two planes 

and the median plane of the body intersect is called the seat reference point (SRP) (Fig. 1a). 

In the standard standing posture, the person must be in a free standing position, erect at full 

height with eyes looking straight ahead, with relaxed shoulders and arms down to the sides 

(Fig. 1b). 
 

Fig.1: Various Heights for Standard Anthropometric Postures 
 

 

Goniometry 

Joint motion is often referred to as joint mobility or joint flexibility. Although joint motion could be 

defined relative to a specific absolute posture, it is generally conceded that body segments rotate about a 

joint; thus the range of motion (maximum angular devotion) available at the joint is the best means to 

express joint mobility. This measure is quite acceptable for primarily simple joint rotation found when 

one flexes or extends the elbow or knee. For more complex joints, such as those at the hips and shoulders, 

motion must be expressed with reference to a particular plane of motion-that is in the sagittal, frontal 

(coronal) or horizontal (transverse) planes. Because of this complication, a set of definitions has been 

developed for all major joints which assume that motion is measured with the person beginning in the 

standard anatomical position.  

Various systems have been developed to measure joint motion which seek to satisfy accuracy, 

repeatability, ease of use, low cost and flexibility one of these systems is "Goniometry". The 

term goniometry is derived from two Greek words "gōnia" meaning angle, and "metron" 

meaning measure. Goniometry refers to the measurement of angles created at human joints by the bones 

of the body. 

A goniometer is a special name given to the sensor that can be attached to measure a joint angle. One arm 

of the goniometer is attached to one limb segment, the other to the adjacent limb segment, and the axis of 

the goniometer is aligned to the joint axis. 

  

Materials and Methods 

1. Anthropometric calipers (The Large Anthropometer has a range of 0 to 60 cm in 0.1 cm increments. 

Popular uses include measuring shoulder width, long bone length and chest depth for tracking 

growth and development of children or for use in motion analysis studies. Aluminum in 



construction, it uses a spring-loaded ball bearing in a sliding C-shaped arm to provide accurate and 

precise measurement. The Small Anthropometer has a range of 0 to 30 cm in 0.1 cm increments. 

Popular uses include measuring wrist, elbow, knee and ankle widths, as well as measuring smaller 

muscle masses like the bicep and calf. Aluminum in construction, it uses a spring-loaded ball 

bearing in a sliding C-shaped arm to provide accurate and precise measurement). 

2. Twin axis goniometers (SG65 (wrist joint) and SG110 (elbow, ankle and neck joints): "SG" series 

twin axis goniometers (Figure 2) permit the simultaneous measurement of angles in two planes, e.g. 

wrist flexion/extension and radial/ulnar deviation. Referring to Figure 3 below rotation of one end 

block relative to the other about axis X-X is measured using the grey plug and the green plug 

measures the rotation of one end block relative to the other about axis Y-Y. 

The working principle of the lab used goniometer is that between the two end blocks inside the 

protective spring there is a composite wire that has a series of strain gages mounted around the 

circumference. As the angle between the two ends changes, the change in strain along the length of 

the wire is measured and this is equated to angle. 

When mounting the goniometer across the joint, the center of rotation of the sensor does not 

coincide with the center of rotation of the joint. As the joint moves through a determined angle the 

relative linear distance between the two mounting positions will change.  

3. Measuring tape 

4. Metric scale 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Figure 2: SG series twin axis goniometers Figure 3: Twin axis goniometer SG series 



Procedure 

Part one- Anthropometry 
 

Practical guidelines for lab: 
 

1. Each member of the lab group will be assigned to a measurement group and will provide that 

measurement to all other members. 

2. Be as accurate as possible in your measurements and follow the procedures as described. 

3. Perform each measurement 3 times and compute the mean of the three performances. 

4. Avoid any kind for bent or unnatural posture. 

5. Avoid keeping an arm outstretched either forwards or sideways. 
 

Height and Length Measurements 
 

1. All heights and lengths should be measured along the Longitudual axis for the total body or the 

segment. 

2. The measuring tape or anthropometer should be placed at the appropriate anatomical location. 

 

Stature Measurement 

The vertical distance from the standing floor to the vertex (the highest point on the head and 

it is dependent on the orientation of the head). 

 

Stature 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

 

Method: 
 

• Ask the subject to stand erect stretching upwards to the fullest extent, 

barefoot on a level floor against the wall with her/his back touching 

the wall and as straight as possible. 

• Mark the required landmarks. 

• Stand on the right side of the subject with measuring tape placed in the 

median sagittal plane of the subject and pulled it taut. 

• Record your reading. 

 
 

Eye height 

Vertical distance from the floor to the inner canthus (corner) of the eye. 
 

Method: 
 

• Ask the subject to stand erect stretching upwards to the fullest extent, 

barefoot on a level floor against the wall with her/his back touching 

the wall and as straight as possible. 

• Mark the required landmarks. 



• Stand on the right side of the subject with measuring tape placed in the median sagittal 

plane of the subject and pulled it taut. 

• Record your reading. 
 

Eye height 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

 

Shoulder height 
 

Vertical distance from the floor to the acromion (the bony tip of the 

shoulder). 

Method: 
 

• Ask the subject to stand erect stretching upwards to the fullest extent, 

barefoot on a level floor against the wall with her/his back touching the 

wall and as straight as possible. 

• Mark the required landmarks. 

• Stand on the right side of the subject with measuring tape placed in the 

median sagittal plane of the subject and pulled it taut. 

• Record your reading. 
 

 

 

Shoulder height 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

 

Elbow height 
 

Vertical distance from the floor to the radiale (The radiale is the bony landmark formed by the upper 

end of the radius bone) 

Method: 
 

• Ask the subject to stand erect stretching upwards to the fullest extent, 

barefoot on a level floor against the wall with her/his back touching the 

wall and as straight as possible. 

• Mark the required landmarks. 



• Stand on the right side of the subject with measuring tape placed in the median sagittal 

plane of the subject and pulled it taut. 

• Record your reading. 
 

Elbow height 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

 

Upper limb length 
 

• Total upper extremity Length 

Distance from the acromion to the fingertip. 

 

Method: 
 

• Ask the subject to stand in a standard arm hanging position. 

• Mark the required landmarks. 

• Stand on the right side of the subject with measuring tape/anthropometer. 

• Record your reading. 
 

Total upper extremity length 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

• Segmental measurements 

a. Shoulder-elbow length (Upper arm length): Distance from the acromion to underside of the 

elbow. 

Method: 

• The subject may stand or sit. His upper arm hangs vertical at his side, making a right angle with 

the forearm. 

• The fixed cross-bar of the anthropometer is placed on the acromion process (the uppermost 

bony point on the lateral aspect of the shoulder), and the movable cross-bar is raised until it 

makes firm contact with the olecranon process (bottom of elbow). 

• The main anthropometer bar is held vertical. 

 

 

Shoulder-elbow length 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

b. Elbow-wrist length (Forearm length): Distance from the back of the elbow to the 

tip of the wrist. 

 

 

 

 



Method: 
 

• The subject may stand or sit, holding his upper arm and forearm as for (a) above. 

• With the main anthropometer bar parallel to the forearm, the fixed cross-bar touches 

the olecranon process (behind the elbow) and the movable arm makes light contact 

with the tip of the wrist. 

 

Elbow-wrist length 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

c. Hand Length: Distance from the crease of the wrist to the tip of the middle finger 

with the hand held straight and stiff. 

Method: 
 

• The subject holds his right hand straight, fingers open stiffly. 

• With the shaft of the small sliding anthropometer parallel to the long axis of the 

subject's hand, the fixed cross-bar is hooked behind the proximal border (away from 

the fingertips towards the wrist) of the navicular bone at the base of the thumb. The 

movable bar of the anthropometer makes light contact with the distal end of the middle 

fingertip. 

 

Hand length 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

Lower limb measurement 
 

• Total lower extremity Length 

It is the vertical distance from standing floor of the subject to iliospinale (It is the most forward 

point on the anterior superior iliac spine) in erect position of the subject. 

Method: 
 

• With subject standing erect. 

• Place the anthropometer/measuring tape vertical on the landmarks 

• Record your reading. 

Total lower extremity length 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

• Segmental measurements 

a. Hip height 
 

Vertical distance from the floor to the greater trochanter (a bony prominence at the upper end of the 

thigh bone). 

 



 

Method: 
 

• Ask the subject to stand erect stretching upwards to the fullest extent, 

barefoot on a level floor against the wall with her/his back touching the 

wall and as straight as possible. 

• Mark the required landmarks. 

• Stand on the right side of the subject with measuring tape placed in the 

median sagittal plane of the subject and pulled it taut. 

• Record your reading 
 

 
 

Hip height 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 

 

b. Knee height 
 

Vertical distance from the floor to the upper surface of the knee (usually measured to the 

quadriceps muscle rather than the kneecap). 

Method: 
 

• Ask the subject to sit erect with legs hanging freely at an angle of 

90°. 

• The body stretched to the maximum. 

• The thighs should be almost horizontal with back of the knee 

touching the vertical surface of the chair and also don't allow the 

knees to bend. 

• The hands should rest on the thighs with palms facing down. 

• Mark the required landmarks. 

• Anthropometer should be held at the front of the subject. 

• Record the reading. 
 

 

Knee length 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

c. Foot length 

Distance, parallel to the long axis of the foot, from the back of the heel to the tip of the 

longest toe. 
 

Method: 
 

• Ask the subject to sit erect with legs hanging freely at an angle of 90°. 

• The body stretched to the maximum. 

 



• The thighs should be almost horizontal with back of the knee touching the vertical surface of the 

chair and also don't allow the knees to bend. 

• The hands should rest on the thighs with palms facing down. 

• Mark the required landmarks. 

• Anthropometer should be held parallel to the long axis of the foot. 

• Record the reading.    

 

Foot length 

Reading 1 ----------------cm 

Reading 2 ----------------cm Mean --------------------- cm 

Reading 3 ----------------cm 
 

Weight Measurement 
 

Weight should be taken by means of standard weighing machine with fine accuracy. The 

weight should be taken barefoot. Body weight is measured in kilograms, which gives an idea 

of body mass. 

Method: 
 

• Ask the subject to stand with equal weight on both the feet. 

• Ask the subject to remove his/her shoes and stand erect at the center of machine platform, 

with arm hanging by the sides of the body. 

• The head of the subject should be forward. 

• Take care that the subject does not move while the measurement is being recorded. 

• Note the reading on the weighing scale. 
 
 

Weight (Total body) 

Reading ----------------Kg 
 

 

Part two- Goniometry 
 

Practical guidelines for lab: 
1. Each member of the lab group will be assigned to a measurement group and will provide that 

measurement to all other members. 

2. Locate the required bony landmarks. 

3. Each joint range of motion (ROM) targeted below will describe the starting position, where to place 

the goniometer, the direction in which the joint should be moved, and hints for accurate ROM 

measurements. 

4. Goniometers should be handled and manipulated as instructed since mishandling may result in 

inaccurate data.   

 

System set up 

1. Make certain that an appropriate Bluetooth adaptor is installed and activated. 

2. Power the desired Bluetooth Data LOG ON and have any other Bluetooth Data LOG units 

      powered OFF. 

 



3. Launch the Data LOG software application, the unit should automatically communicate using 

Bluetooth. (This may take up to one minute).  

4. Open the Detected Units window, if not already open. Go to >View menu>Detected Units. All 

      Data LOG units detected and recognized by the application will be displayed. 

 

Note: If a particular Data LOG was not used the previous time with the PC, then perform the 

Bluetooth 

Scan. Switch on all the desired Data LOG units. Go to >Set up menu >Port and click on > 

Bluetooth Scan. The program will take several seconds to scan for the Data LOG(s) and then will 

communicate using Bluetooth. All the desired Data LOG Units should appear in the Detected 

Units window. The default name for each Data LOG is the Serial Number. 

If there are any problems connecting a Bluetooth Data LOG, quit the Data LOG PC Application, 

turn off the Data LOG unit(s), and then try starting both again. 

 

Connecting Biometrics’ Goniometers 

Wrist flexion and extension 

• For each channel connect the black socket of the J series lead to the black plug of the sensor 

ensuring that the polarization marks are aligned before insertion. (Figure 4) 

 

 

 

• Connect the plug of the J series cable to one of the Analogue Input sockets of the Data LOG. 

Lightly rotate the plug in the socket to align and push to engage with a click. (To remove, hold 

the outer case and pull until it disengages). 

• Start with the subject's shoulder in abduction at 90 degrees and elbow flexed at 90 degrees, such 

that the forearm is close to full pronation. This position is defined as the neutral position. (Figure 

5) 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: Neutral position 

Figure 4: J type interconnect leads 



• Attach the distal end block (SG 65) to the dorsal surface over the third metacarpal with the center 

axis of the hand and end block coincident. 

• While fully flexing the wrist, extend the goniometer and attach the proximal end block to the 

forearm so that the axes of the forearm and end block are coincident. (Figure 6) 

 

 

 

 

 

 

 

 

 

 

 

 

 

• Flex and extend the wrist with the goniometry freely sliding  

• Measurement of flexion/extension is obtained from the grey plug 

• Configure the analog channel: from Set up menu > Analogue Inputs, the Data LOG Analogue 

Inputs dialogue box will be shown. (Enable the checkbox for the active channels, press Zero All 

before recording to perform a zero operation on analogue channels and select the sampling rate 

as instructed), then press Apply and OK. 

• Instruct the subject that the followings will be done during the experiment: 

1. Start from the neutral position (as figure 5). 

2. Keep the hand open and the fingers extended during recording. 

3. Move hand upward (wrist dorsiflexion) from the neutral position as far as possible and hold it 

for five seconds. 

4. Return the hand to the neutral position for five seconds. 

5. Move hand downward (wrist palmar flexion) from the neutral position as far as possible and 

hold it for five seconds. 

6. Return the hand to the neutral position for five seconds. 

7. Continue recording the flexion and extension cycle for two more times 

• Press the Start data transfer / Recording button from the Biometrics Data LOG software or from 

the Data LOG itself and follow the previous recording instructions. 

• After recording the required cycles, press Stop data transfer button. 

• After data collection, a graph of the data automatically displayed. 

 

Data Analysis 

• Scroll through the recording graph and press the “Show All” button from the toolbar, so the three 

extension-flexion cycles are shown. 

• Determine the maximum angle for wrist flexion (palmar flexion) and extension (dorsiflexion), 

time to maximum flexion and extension and time period of wrist flexion (palmar flexion) and 

extension (dorsiflexion) for the three cycles as the table below by press the “Mark Time axis” 

and the “Mark Value axis” from the toolbar and placing the cursors in the correct positions. 

 

 

Figure 6: Goniometer’s position 



• Export the collected data into a specified file by choosing "Export" from File menu.  

• Determine the exported trace and file type from the Export Data File format dialogue box. Then 

press "OK" button. 

 

Wrist Angles (degrees) 

Action 1
st
 2

nd
 3

rd
 Mean 

Extension (dorsiflexion)     

Flexion (palmar flexion)     

Time to maximum flexion     

Time to maximum extension     

Time span for flexion     

Time span for extension     

Maximum flexion velocity      

Maximum extension velocity      

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment #2 

Muscle Biomechanics 

 

Objectives 

 

1. To Understand muscle contraction. 

2. To understand muscle’s force generation mechanism. 

3. To Understand and test factors affecting muscular force generations 

4. To measure maximum weight that can be held at various joint angles 

5. Investigate the relationship between EMG and elbow angle 

 

Theory 
Skeletal muscles are composed of numerous fibers ranging in size from 10 to 80 micrometers. Each of 

these fibers is composed of even smaller subunits called myofibrils. A typical muscle fiber contains 

anywhere from several hundred to several thousand myofibrils, which are composed of approximately 

1500 myosin and 3000 actin filaments. Myosin and actin filaments are large polymerized protein 

molecules that are responsible for muscle contraction.  

 

Muscle contraction occurs in the following steps: 

1. An action potential travels along a motor nerve, arriving at muscle fibers.  

2. Acetylcholine is released at the nerve ending, which then acts on a local area of the muscle fiber 

membrane to open acetylcholine-gated channels.  

3. Large quantities of sodium ions flow to the interior of the muscle fiber membrane through the 

opened acetylcholine-gated channels.  

4. An action potential is produced by the influx of sodium ions. The action potential travels along the 

length of the muscle fiber.  

5. The action potential depolarizes the muscle fiber membrane and travels deep inside the muscle 

fiber, causing the release of stored calcium ions into the myofibrils.  

6. Calcium ions induce attractive forces between actin and myosin filaments, causing them to slide 

over one another. This is the contractile process.  

7. Almost instantaneously, calcium ions are pumped back out of the myofibril to be stored for the 

next action potential. Once the calcium ions are pumped out of the myofibril, muscle contraction is 

ceased. 

 

Types of Muscle contractions: 

1. There are two types of isotonic contractions: (1) concentric and (2) eccentric. In a 

concentric contraction, the muscle tension rises to meet the resistance, then remains the same as the 

muscle shortens. In eccentric, the muscle lengthens due to the resistance being greater than the force the 

muscle is producing. 

2. Isometric contraction is the muscle contraction in which the joint angle and muscle length do not 

change during contraction 

Equipments 

 
1. PC Computer 

2. IWX/214 data acquisition unit 

3. USB cable 

4. C-AAMI-504 EMG cable and electrode lead wires 

5. Disposable electrodes 

6. Different weights 

7. Alcohol swab 



8. Twin axis goniometers (SG110 (elbow joint): "SG" series twin axis goniometers (Figure 1) 

permit the simultaneous measurement of angles in two planes, e.g. wrist flexion/extension and 

radial/ulnar deviation. Referring to Figure 2 below rotation of one end block relative to the other 

about axis X-X is measured using the grey plug and the green plug measures the rotation of one 

end block relative to the other about axis Y-Y. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

EMG Cable Setup 
1. Locate the C-AAMI-504 EMG cable and electrode lead wires in the iWorx kit. 

2. Insert the black AAMI connector on the end of the EMG cable into the isolated inputs of Channels 1 

and 2 of the IWX/214. 

3. Insert the connectors on the red, black, and green electrode lead wires into the matching sockets on 

the lead pedestal of the EMG cable. 

4. The subject should remove all jewelry from their wrists. For the first 

exercises in this lab, record EMGs and muscle forces from the subject’s 

dominant arm, the arm used most often. 

5. Use an alcohol swab to clean and scrub three regions on the inside of the 

subject’s dominant arm where the electrodes will be placed. Three 

electrodes will be used: two electrodes for recording EMG signal and one 

electrode as a reference one.  

6. Let the areas dry before attaching the electrodes. 

7. Remove the plastic disk from a disposable electrode and apply it to one of 

the scrubbed areas (on the biceps muscle of the subject). Repeat for the 

other two areas. 

8. Snap the lead wires onto the electrodes, so that: (see the figure) 

• The red “+1” lead and the black “-1” lead are attached to the electrodes on the biceps. 

• The green “C” lead (the ground) is attached to the electrode on the elbow. 

 

 

Goniometry System Set up 

1. Make certain that an appropriate Bluetooth adaptor is installed and activated. 

2. Power the desired Bluetooth Data LOG ON and have any other Bluetooth Data LOG units 

powered   OFF. 

3. Launch the Data LOG software application, the unit should automatically communicate using 

Bluetooth. (This may take up to one minute). 

4. Open the Detected Units window, if not already open. Go to >View menu>Detected Units. All 

         Data LOG units detected and recognized by the application will be displayed. 

 

 

 

Figure 1: SG series twin axis goniometers Figure 2: Twin axis goniometer SG series 



Note: If a particular Data LOG was not used the previous time with the PC, then perform the 

Bluetooth 

Scan. Switch on all the desired Data LOG units. Go to >Set up menu >Port and click on > 

Bluetooth Scan. The program will take several seconds to scan for the Data LOG(s) and then will 

communicate using Bluetooth. All the desired Data LOG Units should appear in the Detected 

Units window. The default name for each Data LOG is the Serial Number. 

     If there are any problems connecting a Bluetooth Data LOG, quit the Data LOG PC Application, 

turn off the Data LOG unit(s), and then try starting both again. 

 

Connecting Biometrics’ Goniometers 

Elbow flexion and extension 

 

For each channel connect the black socket of the J series lead to the 

black plug of the sensor ensuring that the polarization marks are 

aligned before insertion. (Figure 3) 

 

 

 

 

 

 

• Connect the plug of the J series cable to one of the Analogue Input sockets of the Data LOG. Lightly 

rotate the plug in the socket to align and push to engage with a click. (To remove, hold the outer case 

and pull until it disengages). 

• Start with the subject's shoulder in abduction at 90
º
 degrees and elbow and forearm at neutral.  

• Attach the distal end block (SG 110) to the forearm with the center axis of the endblock coincident 

with the center axis of the forearm (figure 4). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

• With the elbow at neutral, move the goniometer to position 2 (maximum length) and attach the 

proximal endblock to the upper arm with the center of the endblock and the center axis of the upper arm 

coincident.  

 

Figure 4: Goniometer’s position 

Figure 3: J type interconnect leads 



• The elbow may be fully flexed and extended with the distal endblock freely sliding between 

positions 1 and 2. 

•  Measurement of flexion/extension is obtained from the green plug, the grey plug being redundant. 

The distal endblock should be mounted in close proximity to the elbow joint. Movements of pronation 

and supination may be made and will affect the measurement of flexion/extension minimally.  

 

 

Start LabScribe 2 Software 
1. Click on the LabScribe shortcut on the computer’s desktop to open the program. If a shortcut is not 

available, click on the Windows Start menu, move the cursor to All Programs and then to the 

listing for iWorx. Select LabScribe from the iWorx submenu. The LabScribe Main window will 

appear as the program opens. 

2. On the Main window, pull down the Settings menu and select Load Group. 

3. Locate the folder that contains the settings group, IPLMv4.iwxgrp. Select this group and click 

Open. 

4. Pull down the Settings menu again. Select the EMGGripStrength-LS2 settings file. 

5. After a short time, LabScribe will appear on the computer screen as configured by the EMG-

GripStrength-LS2 settings. 

 

Start Biometrics Software 

• Configure the analog channel: from Set up menu > Analogue Inputs, the Data LOG Analogue Inputs 

dialogue box will be shown. (Enable the checkbox for the active channels, press Zero All before 

recording to perform a zero operation on analogue channels and select the sampling rate as 

instructed), then press Apply and OK. 

 

 

Procedure 

Exercise #1: Electromyogram (EMG) signal on Biceps muscle while holding different weights 

at various joint angles  
Explain the experimental procedure of this exercise to the subject: 

• Sit in a comfortable position with back upright and shoulder in abduction at 90
º
 degrees and elbow 

and forearm at neutral. 

• The EMG electrodes were then placed on the subject’s biceps brachii muscle. 

• The SG 110 goniometer was connected as above instructions to measure six different elbow joint 

angles: 0°, 30°, 45º, 60°, 90° and 120°. 

• Carry a weight of 2 Kg with the hand where the electrodes were placed. 

• Press the Start data transfer / Recording button from the Biometrics Data LOG software or from the 

Data LOG itself and follow the previous recording instructions and at the same time press "Record" 

at Labcribe2 software. 

• After recording the required cycles, press Stop data transfer button. 

• After data collection, a graph of the data automatically displayed. 

• Hold the weight at each indicated angle for 50 s.. 

• Stretch the muscle and rest it for 3 minutes 

• Repeat Step (2) for (2) additional weights starting with the lowest available weight as the Table 

below. 

 

Data Analysis 
1. Use the Display Time icons to adjust the Display Time of the Main window to show the complete 

muscle fatigue recording on the Main window. The complete recording can also be selected by: 

• Placing one cursor on the relaxation period just before the contraction and the other cursor on the 

relaxation period. 



• Clicking the Zoom between Cursors button on the LabScribe toolbar to expand the muscle fatigue 

recording to the width of the Main window. 

2. Click on the Analysis window icon in the toolbar or select Analysis from the Windows menu to 

transfer the data displayed in the Main window to the Analysis window. 

3. Look at the Function Table that is above the uppermost channel displayed in the Analysis window. 

The mathematical functions, Abs. Area, V2-V1, and T2-T1 should appear in this table. The values 

for Abs. Area, V2-V1, and T2-T1 on each channel are seen in the table across the top margin of 

each channel. 

 

 

 

 

 

 

 

 

Biceps 

Diameter: 
Age: Gender:  Weight: 

Fitness level: 

(how often do they do 

weight training) 

 EMG (RMS) 

Elbow joint 

angle 
0° 30° 45º 60° 90° 120° 

Weight  (2 Kg) 

 

      

Weight  (4 Kg) 

 

      

Weight  (5 Kg) 

 

      

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment #3 

Force Plate 

Objectives 
 

1. Understand COP. 

2. To learn how to compute the location of the center-of-pressure (COP) under the feet. 

3. To perform a balance assessment of a test subject via measurement of COP with different cases. 

4. To apply Newton's second law. 

5. To understand the forces involved during walking, countermovement jump and running. 

6. To observe how the center of pressure changes during different dynamic activities. 

7. To calculate the flight height of a jump from the time of flight. 

 

Background  

Part A: Quiet Standing Static / Postural Measurements:  
Force/ Moment measurements while the body is in a single position without any movement. Center of 

Pressure: to the point of application of the ground reaction force vector. The center of pressure is not 

constant and is under the influence of sensory feedback of more than one system. This includes the 

visual, auditory, and muscular systems. A force plate is an instrument that measures ground reaction 

forces and is often used in Biomechanics to analyze human posture, gait, and balance. It is also a 

popular instrument in medicine and for sports evaluation. Assume a vertical force Fz is applied a 

distance xcp and ycp from the center of the force plate coordinate system. The force plate would measure 

the force Fz and the associated Mx and My moments generated by the force about the force plate’s x 

and y axes, respectively. Knowing this information, you can then compute the x and y locations of the 

center of pressure as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
The center of pressure when standing is always within the base of support which when standing erect is 

the feet. As long as the COP is within the BOS the subject would not fall/ move. A stabilogram can be 

plotted to track the COP and is often used by clinicians to evaluate different balance related disorders 

such as those related to the vestibular system. 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Part B: Vertical Jump 
The vertical jump is an essential motor skill in many sports. The success or failure of a sportive action 

strongly depends on the ability of the athlete to jump high and fast .This is the reason why many studies 

have analyzed the vertical jump from a physical point of view, to establish the factors that have to be 

improved to increase jump height.  

There are two types of standing vertical jump: "countermovement jump" and "Squat jump" .In a 

countermovement jump (which will be applied during the lab), the jumper starts from an upright 

standing position, makes a preliminary downward movement by flexing at the knees and hips, then 

immediately and vigorously extends the knees and hips again to jump vertically up off the ground 

(Figure 1). A countermovement jump is an example of a movement that benefits from the ‘‘stretch–

shorten cycle.’’ Many human movements such as running, jumping, and throwing involve muscle 

actions in which the desired motion is preceded by a movement in the opposite direction. The muscles 

are said to be ‘‘pre-stretched’’ before shortening in the desired direction. Experiments have 

demonstrated that a pre-stretch enhances the force production and work output of the muscles in the 

subsequent movement. 

In a squat jump, the jumper starts from a stationary semi squatted position then vigorously extends the 

knees and hips to jump vertically up off the ground. 

 

 

 

 
 

 

 

 

 

 

Remember: 

 

 
Eq. (1) 

 

Considering just the vertical component of this vector equation, the forces acting on the body in the z-

direction are the ground reaction force Fz(t) and the force due to the mass of the body, mg. This can be 

related to the vertical acceleration dVz/dt. 

 

Figure3: Vertical ground reaction force (Fz) 

measured by the force plate during a standing 

vertical jump 



 
Eq. (2) 

 
 

Solving Eq. (2) for dVz/dt and integrating results in an expression for the velocity of the whole body 

center of mass as a function of time: 

 

 
Eq. (3) 

 
 

Time of flight: 

Center of mass jump height is purely a function of take-off velocity after take-off. Hence during a 

vertical jump, the total impulse that is imparted to the body will determine the jump height that can be 

achieved. 

 

 

 

 

 

 

 

 

Equipments: 
1. Kistler type 9260AA6 force plate 

2. DAQ connected to the force plate 

3. PC Computer with BioWare software, connected to the DAQ 

 

Procedure 

Part A:COP and Postural Balance 
Starting up the equipment 

a. Turn on the computer  

b. Turn on the DAQand let it warm up for at least 30 minutes. 

Getting the force plate software ready 

• Start the BioWare software by double clicking on the desktop shortcut or Start           Programs                     

           BioWare 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



• From the Tools menu select COP. 

• In the Real -COP dialog box, switch the charge amplifier from "Reset" to "Operate". 

• While the offsets are being read, do not touch the force plate or any buttons. 

• Click on the Setup button in the Real-COP dialog, and choose the rate and length of trial. 

• Ask the subject to stand on the force plate. 

• Click on the Runbutton in the Real-COP dialog box. 

 

Postural Balance 

 
Case Fz(N) Mx(N.m) My (N.m) Xcp (m) Ycp (m) 

Quiet standing/Heels 

together/eyesopened 
     

Quiet standing/eyes 

closed 
     

Quiet 

standing/eyesopened/ 

Mental Task 

     

Body Sway/Hands 

on Hip/ Parallel 

Stance 

     

Body Sway/Hands 

on Hip/ Single Leg 

Stance-Left 

     

Body Sway/Hands 

behind the neck/ 

Single Leg Stance-

Left 

     

 

• To export data from BioWare, select the Save As option from the File menu. 

� Type in your desired filename. 

� Change the Save as type from BioWare files (.dat) to Text files (.txt) so that you can open the data in 

Excel or other software. 

� Check off all of the variables that you wish to export in the Export Device Data dialog  
 
box that appears, and click on the Export Data button. 
� This creates a tab-delimited text file that you can open in many different software. 
 

 

Part B:Vertical Jump 
Starting up the equipment 

a. Turn on the computer  

b. Turn on the DAQand let it warm up for at least 30 minutes. 

 

Getting the force plate software ready 

• Start the BioWare software by double clicking on the desktop shortcut or Start             Programs            

         BioWare. 



 

 

 

 

 

 

 

 

 

 

• Select Acquire Trial from the Data menu, or press the Acquire Trial button underneaththe menus. 

• Adjust the length of the trial and the sampling rate as instructed. 

• Click on the Weigh button in the Acquire Trial dialog. 

• While the offsets are being read, do not touch the force plate or any buttons. 

• Once the Body Weight dialog pops up, ask the subject to stand on the force plate. 

• Click on the Okay button. 

 
Collecting force data from a trial 

• In the Acquire Trial dialog, click on the Start button. 

• Do not touch the force plate or any buttons while the offsets are being read. 

• Avoiding the platform connector, have the test subjectstand on the force platform and position his/her 

feet to form a square on the middle of the platform. Another subject should stand next to the test subject 

to recording his/her jump. 

• When the Press enter to begin acquisition dialog appears, you are ready to start the trial. 

• Press Enter, or click on the Okay buttonto start the trial. 

• Instruct the test subject to start countermovement jump: start out standing straight up, then bend 

his/her knees, then push off and jump up as high as he/she could, and land back on the force 

plate. 

• Save and Export the data. 

 

 

 

Data Analysis (Calculations, Results and Discussion) 

Part A 

1. Regarding your experimental results during the lab, plot the stabilogram for the following cases (using 

excel or Matlab). 

 

 
 

Case Fz(N) Mx(N.m) My (N.m) Xcp (m) Ycp (m) 

Quiet 
standing/eyes 

opened 

     



Quiet 

standing/eyes 
closed 

     

Body 

Sway/Hands 

on 

Hip/ Single 

Leg Stance-

Left 

     

Body 

Sway/Hands 

behind the 

neck/ Single 

Leg 
Stance-Left 

     

 
 

*Show your calculations 
 

 

1. For each stabilogram, what are the COP ranges (in cm) in both the x and y axes? 

 

 

 

2. Plot the ground reaction force Fz (N) as a function of Time (sec) for Quiet Standing/eyes opened. 

 

 

 

3. How does the center of pressure motion differ between the eyes opened and eyes closed conditions? 

Explain. 

 

4. How does the value of Fz change during different cases? 

 

 

 

 



5. Does the COP location vary more in the anterior – posterior (x-axis) or left – right (y-axis) direction? 

Suggest some possible reasons for your observations. 

 

 

Part B 

1. Plot the ground reaction force Fz (N) as a function of Time (sec).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Identify the point on your graph corresponding to each of the followings: 

a. The start of the crouch preceding jump 

b. The highest point of the jump 

c. The lowest point of the crouch 

d. The jumper's feet touch the ground at the end of the jump 
 

3. From the force graph, calculate the time of flight (how long you were in the air). 

Flight Time =  

 

4. From the flight time, calculate the height of the subject's jump. 

Jump Height =  

 



5. Estimate the subject's jump height from the recorded video and compare with the calculated one. 

6. Plot the forces in (x) and (y) directions as a function of Time (sec). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7. Plot and explain the change of Center of Pressure during jump. 

8. Describe the benefits of knees bending before start jumping and while landing. 

9. Compare and discuss the results for the three subjects. 

10. What are the possible errors in your calculations or measurements? 

 

Note: You have to analyze data and answer the questions for the three tested 

subjects  
 

 

Conclusion 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment #4 

Gait Analysis  

 

Objectives 

1. To apply Newton's second law. 

2. To understand Gait Analysis concept and its applications in biomedical engineering. 

3. To learn the different methods (force plate and goniometer) used to analyze and measure gait of a    

     human subject and compare between them. 

4. To understand the forces involved during walking and running. 

5. To understand the change of human patterns due to walk constrains applied on the limbs. 

 

Theory 

Part A: Gait Analysis/Walking 
Gait: is the sequence of walking functions by a single limb. The gait cycle is divided into stance and 

swing phases (Figure1); stance is the entire period of which the foot is on the ground while the swing 

phase is the time the foot is in the air for limb advancement, it begins when the foot is lifted from the 

floor. The last part of the foot to leave the floor is the toe so that subdivision is called “toe off”. 

 

The initial double stance begins the gait cycle. It is the time both feet are on the floor after initial contact. 

Single limb support begins when the opposite foot is lifted for swing. 

Terminal double stance: begins with floor contact by the other foot (contralateral initial contact) and 

continues until the original stance limb is lifted for swing (ipsilateral toe-off). 

 
 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure1: Gait Cycle phases 

Figure 2: Division of Gait 

Cycle phases 



Part B: Gait Analysis/ Running 
Running is a method of terrestrial locomotion allowing humans to move rapidly on foot. Running is a 

type of gait characterized by an aerial phase in which all feet are above the ground (though there are 

exceptions). This is in contrast to walking, where one foot is always in contact with the ground, the legs 

are kept mostly straight and the center of gravity vaults over the stance leg or legs in an inverted 

pendulum fashion. A characteristic feature of a running body from the viewpoint of spring-mass 

mechanics is that changes in kinetic and potential energy within a stride occur simultaneously, with 

energy storage accomplished by springy tendons and passive muscle elasticity. The term running can 

refer to any of a variety of speeds ranging from jogging to sprinting. 

Running requires: greater balance, greater muscle strength, greater joint range of movement. 

 

 

 

 

 

 

 

 

 

 

 

 

Materials: 
1. Kistler type 9260AA6 force plate. 

2. DAQ connected to the force plate. 

3. PC Computer with BioWare software, connected to the DAQ 

4. Twin axis goniometer (SG 150) 

5. DataLOG MWX8 data acquisition unit with Biometrics DataLOG software. 

6. Wood pieces 

7. Tape 

8. Video camera 

 

Method 

Goniometry system set up 

1. Make certain that an appropriate Bluetooth adaptor is installed and activated. 

2. Power the desired Bluetooth DataLOG ON and have any other Bluetooth Data LOG unit powered OFF. 

3. Launch the Data LOG software application, the unit should automatically communicate using Bluetooth. 

(This may take up to one minute).  

4. Open the Detected Units window, if not already open. Go to >View menu>Detected Units. All Data 

LOG units detected and recognized by the application will be displayed. 

 

Note: If a particular Data LOG was not used the previous time with the PC, then perform the 

Bluetooth 

Scan. Switch on all the desired Data LOG units. Go to >Set up menu >Port and click on > 

Bluetooth Scan. The program will take several seconds to scan for the Data LOG(s) and then will 

communicate using Bluetooth. All the desired Data LOG Units should appear in the Detected 

Units window. The default name for each Data LOG is the Serial Number. 

If there are any problems connecting a Bluetooth Data LOG, quit the Data LOG PC Application, 

turn off the Data LOG unit(s), and then try starting both again. 

 

Figure 3: Phases of Running 



Connecting Biometrics’ Goniometers (Knee goniometer) 

• For each channel connect the black socket of the J series lead to the black plug of the sensor ensuring 

that the polarization marks are aligned before insertion. (Figure 4) 

 

 

• Connect the plug of the J series cable to one of the Analogue Input sockets of the Data LOG. Lightly 

rotate the plug in the socket to align and push to engage with a click. (To 

remove, hold the outer case and pull until it disengages). 

• Start with the subject standing in neutral position with the foot on a flat 

surface. 

• Mount the distal end block laterally on the leg so the axes of the leg and 

end block coincide when viewed in the sagittal plane (figure 5), with the 

leg fully extended in the position of reference extend the goniometer to 

position 2 (maximum length) and attach the proximal end block to the 

thigh so the axes of the thigh and end block coincide.  The knee may now 

be flexed or extended with the goniometer freely sliding between positions 

1 and 2. 

• Measurements of flexion/extension may be monitored using the 

green plug, the grey plug being redundant.  

• Configure the analog channel: from Set up menu > Analogue Inputs, the Data LOG Analogue Inputs 

dialogue box will be shown. (Enable the checkbox for the active channels, press Zero All before 

recording to perform a zero operation on analogue channels and select the sampling rate as instructed), 

then press Apply and OK. 

 

Getting the force plate software ready 

• Turn on the computer 

• Turn on the DAQ and let it warm up for at least 30 minutes. 

• Start the BioWare software by double clicking on the desktop shortcut or Start         Programs           

BioWare. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 5: Knee goniometer position 

Figure 4: J type interconnect leads 



• Select Acquire Trial from the Data menu, or press the Acquire Trial button underneath the menus. 

• Adjust the length of the trial and the sampling rate as instructed. 

• Click on the Weigh button in the Acquire Trial dialog. 

• While the offsets are being read, do not touch the force plate or any buttons. 

• Once the Body Weight dialog pops up, ask the subject to stand on the force plate. 

• Click on the Okay button. 

• In the Acquire Trial dialog, click on the Start button. 

• Do not touch the force plate or any buttons while the offsets are being read. 

• When the Press enter to begin acquisition dialog appears, you are ready to start the trial. 

• Press Enter, or click on the Okay button to start the trial and at the same time press the Start data 

transfer / Recording button from the Biometrics Data LOG software or from the Data LOG itself and 

follow the instructions for each part. 

 

Part A: Normal gait/ Walking 

• Instruct the test subject to walk normal along the length of the walkway and making sure that he/she 

starts and ends walking before going on the walkway. 

• Another subject should stand next to the test subject (from the sagittal and the frontal levels) to 

recording his/her walking (make sure it captures the motion of the lower limbs and covers the length of 

the platform). 

• Repeat the steps above for other two subjects. 

• Use one of the following soft wares to analyze the angles of the knee joint: 

a) Photoshop 

b) ImageJ from: https://imagej.nih.gov/ij/  

c) Kinovea from: http://www.kinovea.org/en/ 

 

Part B: Normal gait /Running 

• Instruct the test subject to run along the length of the walkway and making sure that he/she starts and 

ends walking before going on the walkway. 

• Another subject should stand next to the test subject (from the sagittal and the frontal levels) to 

recording his/her walking (make sure it captures the motion of the lower limbs and covers the length of 

the platform). 

• Repeat the steps above for other two subjects. 

• Use one of the following soft wares to analyze the angles of the knee joint: 

a) Photoshop 

b) ImageJ from: https://imagej.nih.gov/ij/  

c) Kinovea from: http://www.kinovea.org/en/ 

 

Part C: Abnormal gait /Walking 

• Extend the test subject knee (the one that is not connected to the goniometer) and fixed it by using two 

pieces of wood with tape (make sure that the knee could not move any more). 

• Instruct the subject to try walking for a short time before start collecting data, until he/she is ready to 

walk with this abnormality. 

• Instruct the test subject to walk along the length of the walkway and making sure that he/she starts and 

ends walking before going on the walkway. 

• Another subject should stand next to the test subject (from the sagittal and the frontal levels) to 

recording his/her walking (make sure it captures the motion of the lower limbs and covers the length of 

the platform). 

• Repeat the steps above for other two subjects. 

• Use one of the following soft wares to analyze the angles of the knee joint: 

 



a) Photoshop 

b) ImageJ from: https://imagej.nih.gov/ij/  

c) Kinovea from: http://www.kinovea.org/en/ 

Note: 
• To export data from BioWare, select the Save As option from the File menu. 

� Type in your desired filename. 

� Change the Save as type from BioWare files (.dat) to Text files (.txt) so that you can open the 

data in Excel or other software. 

� Check off all of the variables that you wish to export in the Export Device Data dialog box that 

appears, and click on the Export Data button. 
� This creates a tab-delimited text file that you can open in many different software. 

 

• For Biometrics DataLOG software 

• After recording the required gait cycle, press Stop data transfer button and a graph of the data 

automatically displayed. 

• Export the collected data into a specified file by choosing "Export" from File menu.  

• Determine the exported trace and file type from the Export Data File format dialogue box. Then press 

"OK" button. 

 

 

Data Analysis (Calculations and Results) 

Force Plate and Gait Analysis 

1. Plot the ground reaction force Fz (N) as a function of Time (sec) for normal gait during walking and 

running and abnormal walking gait for each subject.  

 

 

 

 

 

 

 

 

 

 

 

 



2. Measure the time interval for stance phase and swing phase for one foot during walking (normal and 

abnormal gait) and running for each subject. Compare between the three motion patterns. 

 

 

 

3. Discuss the change in the test subject response to overcome the abnormality during walking?   

 

 

 

 

Goniometer and Normal Walking Gait Analysis 

4. Plot the knee joint angle as a function of Time (sec) recorded by Biometrics DataLOG software. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
5. Plot the knee joint angle as a function of Time (sec) recorded by the video camera. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
6. Compare the two plots (Questions 4 and 5) above with the expected normal range of knee motion as the 

figure below.  



 

 

 

 

 

 

 

 

 

 

 

 

Goniometer and Abnormal Walking Gait Analysis 

7. Plot the knee joint angle as a function of Time (sec) recorded by Biometrics DataLOG software. 

 

 

 

 

 

 

 

 

 

 

 

 

 
8. Plot the knee joint angle as a function of Time (sec) recorded by the video camera. 

 

 

 

 

 

 

 

 

 

 

 

 
9. Compare the two plots (Questions 7 and 8) above with the expected normal range of knee motion as the 

figure in question (6).  

 

Note: You have to plot the graphs by Matlab or Excel 

 

 



 

Part II: Mechanical Properties of Biomaterials  
Objectives 

• Understand the principle of tension and compression tests. 

• Understand the Stress-Strain curve and learn how to use it in determining various mechanical 

properties of different materials: modulus of elasticity, yield strength, ultimate tensile strength and 

elongation (ductility). 

• Apply the creep test for different materials. 
 

Preface 

Materials that are used for biomedical  applications are known as biomaterials. Properties of 

biomaterials that have been used for implants are directly influence and control the tissue interface 

dynamics from the time of initial in vivo placement until final disposition.  

Three requirements must be met to classify the material for biomedical application: the first requirement 

is that the material must be biocompatible; it means that the organism should not treat it as a foreign 

object. Secondly, the material should be biodegradable; the material should harmlessly degrade or 

dissolve in the body of the organism to allow it to resume natural functioning. Thirdly, the material 

should be mechanically sound; for the replacement of load bearing structures, the material should 

possess equivalent or greater mechanical stability to ensure high reliability of the graft. 

Biomaterials played a significant role in the development of new medical innovations and research. 

Developments in areas such as 3D printed medical devices, bio fabricated tissue engineering scaffolds, 

and biodegradable meshes provide a basis for future clinical treatments. These innovations have the 

capability to disrupt the current medical industry by providing novel solutions to historical challenges in 

patient health. 

  

Biomedical engineers use biomaterials for the following broad range of applications: 

• Medical implants, including heart valves, stents, and grafts; artificial joints, ligaments, and 

tendons; hearing loss implants; dental implants; and devices that stimulate nerves. 

• Regenerated human tissues, using a combination of biomaterial supports or scaffolds, cells, 

and bioactive molecules.  Examples include a bone regenerating hydrogel and a lab-grown 

human bladder. 

• Molecular probes and nanoparticles that break through biological barriers and aid in cancer 

imaging and therapy at the molecular level. 

• Biosensors to detect the presence and amount of specific substances and to transmit that 

data.  Examples are blood glucose monitoring devices and brain activity sensors. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

Experiment #5 

Tension and Compressive Tests 

 

Objectives 

 
1. To be familiar with the material testing machine(810LE4) and provide a practical exercise for 

using it to determine the mechanical properties of different materials. 

2. To understand the principle of tension and compression tests as well as practice how to operate the 

universal testing machine (810LE4) in a tension and compression manners. 

3. To understand the behavior of a material while it experiences a compressive load by measuring 

fundamental variables, such as, strain, stress, and deformation. 

4. To understand the Stress-Strain curve and learn how to use it in determining various mechanical 

properties of different materials (Aluminum, Copper, Cast iron and Stainless Steel): modulus of 

elasticity, yield strength, ultimate tensile strength and elongation (ductility). 

 

Theory 
The evaluation of the mechanical behavior of a sample under conditions of tension and compression 

can be performed to provide basic material property data that is critical for component design and 

service performance assessment. The requirements for tensile and compression strength values and the 

methods for testing these properties are specified in various standards for a wide variety of materials. 

Testing can be performed on machined material samples or on full-size or scale models of actual 

components. These tests are typically performed using a universal mechanical testing instrument. 

A tensile test, also known as tension test, is probably the most fundamental type of mechanical test you 

can perform on material to recognize its strength and its mechanical behavior. 

Tension test, in which a strip or cylinder of the material, having length L and cross-sectional area A, is 

anchored at one end and subjected to an axial load P – a load acting along the specimen’s long axis – 

at the other. As the load is increased gradually, the axial deflection δ of the loaded end will increase 

also. Eventually the test specimen breaks or does something else catastrophic, often fracturing 

suddenly into two or more pieces. 

The strain resulting from the stress applied is proportional to the stress and is directly related to it with 

a proportionality constant called the Elastic Modulus/ Young’s Modulus. This constant is material 

dependent and only applies in what is called the "elastic region" of a material’s behavior through the 

following equation: 
 

 

 

Where (�) is the Stress in Pascal, (�) is the Strain and (E) is the Elastic Modulus or Young’s Modulus 

A typical stress-strain curve is shown in the figure below: 
 

 

 

 

 

 

 

 

 

 

 

 

 

� = �� 
 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note that stress - strain proportionality only applies in the elastic region (up to the yield stress point), 

also note that this curve assumes a constant cross-sectional area and does not take into consideration 

the Poisson’s Ratio. The Poisson’s Ratio (ν) is the ratio of transverse contraction strain to longitudinal 

extension strain in the direction of stretching force and is approximated to be 1/3 for isotropic metals 

and ½ for anisotropic polymers. 

 
A compression test is a method for determining the behavior of materials under a compressive load. 

Compression tests are conducted by loading the test specimen between two grips, and then applying a 

force to the specimen by moving the crossheads together. During the test, the specimen is compressed, 

and deformation versus the applied load is recorded. The compression test is used to determine elastic 

limit, proportional limit, yield point, yield strength, and (for some materials) compressive strength. 

 

Definitions 

• Gauge Length (L) - length of the test specimen on which elongation is measured at any moment 

during the test [m]  

• Original Gauge Length (L0) - gauge length before application of load [m] 

• Final Gauge Length (Lu) - gauge length after rupture of the test specimen [m] 

• Elongation - increase in the original gauge length at the end of the test 

• Stress (σ)- load at any moment during the test divided by the original cross-sectional area of the test 

specimen [Pa/ (N/m
2
)] 

•  Strain- It is the ratio of change in length to the original length (� =
∆�

�	
) 

• Elastic Modulus-a measure of the stiffness of the material, but it only applies in the linear region of 

the stress – strain curve ( � = �/�) , [Pa] 

• Yield Stress (σy)-when the material exhibits a yield phenomenon, a point is reached during the test at 

which plastic deformation occurs without any increase in the load [Pa/(N/m
2
)]  

• Ultimate Tensile Stress (σu)-the maximum load the specimen sustains during the test[Pa/ (N/m
2
)] 

Materials 
1. PC Computer 

2. Universal Testing Machine (800LE Series Hardware) 

3. Vernier Caliper and scale 

4. Tested Specimens  

Stress versus Strain Curve 



 

 

Universal Testing Machine Overview 

 
Biomaterial testing machine is used to generate force and measure fatigue, fracture, tensile and 

compression test results on mechanical test samples. They are capable of producing static and cyclic 

loads in tension or compression and operate to speeds of depending on the system performance 

 

System Components 

 
Test system typically consists of: 

1. Frame  

2. Actuator 

3.  Power module electronics 

4.  Controller with interconnect cables 

 

Each system includes a power pack with the following 

operator indicators and switches: 

• System ON/OFF 

• System Enable LED 

• Emergency Stop 

 

 

 

Safety Warnings 
1. Excessive side load on the output rod of the actuator will 

dramatically reduce the life of the Actuator and should be 

avoided completely. Side load can be caused from 

misalignment or Loading of the specimen which is not in 

line with the axis of motion. 

1. The equipment may be so heavy. Don't move it. 

2. Never lift the equipment by the actuator rod. 

3. Never use the system if it appears damaged in any way. 

4. This equipment may contain sensitive position sensors 

and should be handled with care. 

 

General Safety Concerns 
Mechanical testing is an inherently dangerous activity since the product being tested may behave or 

fail in a way that is not expected. The nature of testing is to determine what happens when various 

conditions are present that have never been tested before In addition, servo-controlled systems, by their 

nature have many variables that must be factored in real time by the operator of the machine. In many 

cases, the person wanting to operate the machine may be lacking in training or experience and so may 

choose to place a sample in a dangerous mode. This is the nature of performing research on new 

products and materials. Since all materials and products fail in different modes, the user is responsible 

to determine the risk and to solve the problem of minimizing it. 

For example, if the material tested is brittle and fails in a catastrophic and dangerous manner, a safety 

enclosure is recommended to contain the product being tested. 
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Specimen 

Grips 



 

 

Method 

Part A: Tension Test 

 
1. Prepare Test Specimen: During the lab different materials with different properties will be used.  

 

For each test specimen, determine the following parameters as the table below: 

 

Parameter 
Type of Test Specimen 

------------------------- 

Type of Test 

Specimen 

----------------------- 

Gauge length (L0)  

(mm) 

  

Width (w) 

(mm) 

  

Thickness (t) 

(mm) 

  

 

 
2. Check that all cables are properly and securely connected. Switch on all power Switches in the 

following sequence: 

a. Main power switch  

b. Control Power 

c. Computer. 

 

A Five minute warm up period is necessary before starting your test. 

 
3. Start the Software: 

a. Double click on the “TestBuilderV3” icon. The software will connect automatically. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
b. Click on the "proceed " button 

c. The TestBuilderV3 main screen will appear as shown below. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
d. Click on the "Function Generator" The function generator application is intended for simple movement 

of the actuator.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

e. Use position mode to jog the load cell and fixtures. 

 

 

f. Select the Jog button down the right hand side of the software screen. The Jog panel allows you to  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



g. Tare readout: In most cases before you, insert your sample into the fixtures on the test machine you 

will want to tare or zero the weight of the fixture, because this is not load seen by the sample. To tare 

or zero the weight of the fixture. Click on the setup on the top menu bar as shown below and click on 

“offset Readout”. 

h. Start the tensile test (Tension) by carrying out the following procedure:  

• Click the DAQ button enter the DAQ rate use 50 for static test then save your folder 

• Start you test by switch on the function generator 

 

 

Note: You could always stop a test by pressing the Emergency Stop Button, which isa large, round, 

red button located on the front of the load frame. Press this button to Stop crosshead travel 

immediately when a condition develops that could affect the Safety of persons operating the system, or 

could damage the specimen or the test Fixtures. Pressing the Emergency Stop Button stops the system 

instantly and disables the frame’s drive motor. 

 

• Once you’ve completed your test Click on the Report icon to generate a report and export to excel. 

 

 

 

 

• Once tensile testing is complete, remove the test specimen from fixtures. 

• Repeat the procedure for the second specimen. 

 

 

Part B: Compression Test 

 
1. Measure and record the specimen dimensions prior to testing as the table below. 

Parameter 
Specimen #1 

---------------------- 

 Specimen #2 

---------------------- 

Gauge Height (H0)  

(mm) 

  

Gauge Diameter 

(D0) 

(mm) 

  

 

 

 

2. Load the specimen between the two grips of the Universal Testing Machine. 

3. Start the compression test (as Lab instructions). 

4. Once compression test is complete, remove the test specimen from grips. 

5. Measure the final diameter and height of the specimen. 

 

 

Parameter 
Specimen #1 

---------------------- 

 Specimen #2 

---------------------- 

Final Height (Hf)  

(mm) 

  

Final Diameter (Df) 

(mm) 

  

 

 

 



High 
Temperature or 
Stress 

Medium 
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e or Stress 
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Stress 

Experiment #6  

Creep Test 

Objectives 

1. To understand the principle of Creep test. 

2. To study the time-dependent deformation (creep) of different materials (Lead). 

3. To calculate the creep rate ( ��� and the strain hardening (n) coefficient. 

 

Theory 
When the stress on a material takes the material above its elastic limit into itsplastic region, then the 
material permanentlydeforms. If the stress is maintained, the deformation (strain) continues. This slow, 
gradual deformation is called ‘creep’. It is an increase in strain over time. Creep happens due to long 
term stress levels that are below yield stress. The material permanently deforms to relieve the stress. 
Creep is easily measured in pure metals when their temperature is one third (or 30%) of their melting 
temperature. 

 

Four main things determine the speed and amount of creep: 

 
• Applied load - higher loads give higher stresses that increase the speed of creep 
• Type of material - softer materials creep more quickly for the same value of stress 
• Dimensions of the material - thinner materials take higher stresses for the same value of load 
• Temperature of the material - higher temperatures encourage faster creep 

 

Creep testing aims to investigate plastic deformation of a material when subjected to a constant load or 

stress at varying temperatures. Temperature allows materials to deform more easily since atoms can move 

more readily, hence, greater movement of dislocations or slips.  

New slip systems and grain-boundary movement are also possible at higher temperatures. Therefore, 

engineering alloys utilized at high temperatures is susceptible to creep as well as recrystallization and grain 

coarsening. In the case of age-hardened metals, over-ageing is feasible, which results in reduced hardness 

and strength due to the coarsening of the second phase precipitates. 

Due to a significant degradation of mechanical properties with time, structural materials can generally 

withstand mechanical loading at different temperatures in a certain period of time (strong time dependence 

of strength). Maintenance or replacing of new materials is therefore necessary for safety reasons.  

Note that creep testing is noticeably different from tensile testing. For example, a tensile test requires less 

time to actually finish the test. A. creep test might require 10,000 hours to finish the test. Therefore, creep 

study is required for materials subjected to high loads for extended periods of time to prevent creep failure 

during service operations. 

 

 

 

 

 

Figure 1: Curves of Creep at Different Temperatures 

and Stress 



Material Failure (Fracture) 

 
When a material is subject to creep, after enough time, the material will fail (fracture). Different materials 
will fracture after different amounts of deformation. 

 
Rubber materials can deform much more than plastic materials before they fail. Plastic materials can 
deform much more than metals before they fail. Metals can deform much more than silicone based material 
before they fail. This is because the failure is determined by the molecular structure of the material. 

 

Three Stages of Creep 

 
Even though the applied stress and temperature on a piece of material may be constant, creep is not 
completely linear. It has three main stages: 
 

• Primary creepor ‘Transient’ Creep: in which the creep resistance increases with strain leading to 

a decreasing creep strain rate. 

• Secondary (Steady State) creepor ‘Quasi-viscous’ Creep: in which there is a balance between 

work hardening and recovery processes, leading to a minimum constant creep rate. 

• Tertiary creep: in which there is an accelerating creep rate due to the accumulating damage, which 

leads to creep rupture, and which may only be seen at high temperatures and/or stresses and in 

constant load machines. 

 

Each stage of creep behavior is influenced from both work hardening and annealing mechanisms occurring 

at the same time. However, work hardening and annealing will take place at different rates depending on 

response of metals to applied tensile force with time. The creep rate therefore changes accordingly.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

� Primary creep does not start until the material has passed its elastic limit. 

The secondary creep stage is almost linear because this is the stage where the material is actually 
becoming ‘work hardened’, which helps to resist the load. The gradient of the secondary creep 

determines the creep rate for the material. 

 
The point between the second and third stage is the ‘Transition Point’. This indicates that the material is 
starting to fail and may already start to crack in places. 

 

Figure 2: Standard creep figure 
 



Engineers must realize that they can allow materials to enter the first and second stages of creep, but never 
the third, as the part (or structure) will fail. It is important for engineers to know the second stage creep 
rate, so that they when to change a part in a machine or structure. 

 

Calculation of Creep Rate (secondary creep) 
 
Secondary creep rate is linear, so to find it you only need a measurement of the change in dimension 
(strain) of the material over time, from a test at a constant temperature and stress. The equation for this is: 
 

	�� =
Δ�

Δ�
 

 

 

Useful Equations 
 

Strain-Hardening Coefficient (n) 

When many materials are stressed they actually become harder and resist the stress. This is also known as 
work hardening. It is the gradient of a graph of the natural log values of stress and strain in a material in its 
plastic region. 
 

It is found by the equation: 

 

� =
Δ ln�

Δ ln 	��
 

 

 

Equipments 

 
9. Creep Machine SM1006 

10. Test specimens: Lead, Polypropylene 

11. Stopwatch 

12. Vernier caliper 
 

 

Creep Machine Description: 

 

The Creep Machine is a simple lever and weight machine. It has a long lever (Arm) with a pivot point   
near to one end. The pivot point is a bearing, for very low friction. Students fit specimens of different 
materials to the short end of the lever and known weights to the long end of the lever. The lever gives a 
large mechanical advantage, so that even small weights will apply a large load (tensile stress) to the 
specimen. This simple system gives a predictable, uniform and constant load to the specimen. 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Procedure 

 

Calculation of the Stress on a Specimen 

1. Calculate the total mass at the end of the Arm (point ‘P’). To do this, add together: 

 
• The value of the weight you are to add to the Weight Hanger 
• The Effective mass of the Arm at ‘P’ 
• Mass of the Weight Hanger 
• Mass of the Support Pin 

 

* The mass of these parts is written on the Base Plate of the Creep Machine 
 

2. Multiply the total mass by 8 (the mechanical advantage of the Arm), and then by 9.81 (acceleration due 
to gravity). This will give the total force on the specimen in Newtons. 

3. Calculate the cross sectional area of the specimen (width x thickness) in m
2
. 

4. Divide the total force (Newton) by the cross sectional area (m
2
) to find the stress on the specimen (in 

N.m
-2

). 

Prepare the Specimen 

 
5. Accurately measure and record the width and thickness of each tested specimen. 

Parameter 
Type of Test Specimen 

------------------------- 

Type of Test Specimen 

----------------------- 

Gauge length (L0)  

(mm) 

  

Width (w) 

(mm) 

  

Thickness (t) 

(mm) 

  

 



6. Put the weight hanger in position and fit its support pin in its highest hole to hold the arm up and ready 

for the test specimen. 

7. Fit the steel specimen support clips to the specimen. 

8. Fit the specimen into place between the black support block and the arm, and fit the pins. 

9. Put the transparent cover into place around the specimen. Make sure that the thermometer is in its hole 

in the top of the cover and its tip is near to the specimen. Wait for at least five minutes for the 

temperature reading to stabilize, then record the temperature around the specimen. 

10. Carefully remove the Weight Hanger support pin from the highest hole in the Weight Hanger. 

11. Switch on the digital indicator and press its origin button to set its display to zero. Make sure that     it 

is set to work in reverse (press the +/- button so that the word REV is shown in its display). 

12. Lift the Weight Hanger and support it while you fit the support pin in the lowest hole. 

 
13. Gently (and at the same time) - let go of the Weight Hanger and start your timer. Slide the rubber mat 

(supplied) onto the Base Plate, underneath the Weight Hanger. 

 

14. Record the specimen extension every 3 seconds until it fractures or stops extending due to the limits of 
the machine. 

 

15. Repeat the test by applying different weight (at room temperature). 

16. Repeat the test on different specimen material by applying two different weights. 

17. Repeat the test for the two specimens at the highest weight, but use the cool pack to increase the 
temperature around the specimen before you start the test. Heat the cool pack and put it next to the 
specimen before you fit the transparent enclosure. 

 

18. For each specimen, fill the table below: 

 

Specimen Material: 

Temperature around Specimen: 

Applied Weight: 

Total Mass at 'P': 

Load = ----- N Load = ----- N 

Time 

(sec) 

Elongation 

(∆L) (mm) 

Strain 

(ε) 

Time 

(sec) 

Elongation 

(∆L) (mm) 

Strain 

(ε) 

 

 



Part III: Biofluid Mechanics 
Objectives 

• Emphasize the application of fluid mechanics principles to major human organ systems. 

• Principles such as the conservation of energy and mass will be applied to various human body 

systems in addition to fundamental equations including continuum equations. 

• Examine the flow pattern around a body or over its surface. 

 

Preface 

Biofluid mechanics is a vast field that involves fluid motion inside and outside living organisms. The 

human circulatory system illustrates some of the many challenges associated with understanding and 

modeling biological fluid flows. It is a branched network of flexible-wall vessels through which a non-

Newtonian fluid flows in an unsteady manner. The branched geometry of the blood vessels minimizes flow 

resistance while providing a large surface area at the capillary level for the exchange of oxygen, nutrients, 

and wastes that are carried to or from the body's tissues. The flexibility of the large arteries partially 

smooth the pressure pulses produced by the heart's rhythmic pumping. Both the protein content and the 

presence of red blood cells contribute to the shear thinning character of blood. Models of steady and 

unsteady flow in straight tubes having appropriate properties are reasonably successful in explaining many 

features of human blood circulation.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Experiment #7  

Venturi Meter 

 

 

 

Objectives 

1. To understand the principle of venturi meter 

2. Show the relationship between flow area, pressure head, velocity head, and head loss through an 

expansion. 

3. Calculate the flow rate given the drop in pressure through the contraction and the area of the two 

cross-sections 

 

Background 

The Venturi Effect and Bernoulli’s Theorem 
The Venturi Effect is named after an Italian physicist - Giovanni Venturi from the 18th century. 

He found that the pressure of a moving fluid drops when it passes through a constriction in a 

pipe. Around the same time, a dutch-swiss mathematician - Daniel Bernoulli experimented with 

fluid dynamics, leading to Bernoulli’s principle. This principle stated that a change in fluid 

velocity is directly linked to a change in its pressure (or potential energy). 

 

Bernoulli’s principle assumes that the fluid flow is inviscid - the fluid has no viscosity. In reality 

most fluids have some value of viscosity. 

 

To obey the laws of fluid dynamics for an incompressible fluid, its velocity increases as it passes 

through a constriction, thereby conserving mass. If the flow remains constant, its pressure must 

decrease, thereby conserving energy. 

 
Figure 1 shows an incompressible fluid flowing along a convergent-divergent pipe with three 
pressure tappings. One tapping measures upstream pressure at section 1, the second measures 
pressure at the throat (section 2) and the third measures pressure downstream (section 3). The 
cross-sectional area at the upstream section 1 is a1 and at throat section 2 is a2. Any other 
arbitrary section n is an. Piezometer tubes at these sections register h1, h2 and hn as shown. 
 
 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1: Ideal Conditions in a Venturi Meter 
 



A venturi meter is a measuring or also considered as a meter device that is usually used to measure the 

flow of a fluid in the pipe. A Venturi meter may also be used to increase the velocity of any type fluid 

in a pipe at any particular point. It basically works on the principle of Bernoulli's Theorem. The 

pressure in a fluid moving through a small cross section drops suddenly leading to an increase in 

velocity of the flow. The fluid of the characteristics of high pressure and low velocity gets converted to 

the low pressure and high velocity at a particular point and again reaches to high pressure and low 

velocity. The point where the characteristics become low pressure and high velocity is the place where 

the venturi flow meter is used. 

 
Assuming that there is no loss of energy along the pipe, and that the velocity and piezometric 

heads are constant across the cross-sections of each of the sections considered, then Bernoulli’s 

theorem states that: 

 

 

 

 

 

 
where u1, u2 and un are the velocities of flow through sections 1, 2 and n. 

The equation of continuity assumes constant flow volume (not velocity) along the pipe, so: 

 

 

 

 

Substituting in Equation 1 for u1 from Equation 2: 

 

 

 

 

and solving this equation for u2 leads to: 

 

 

 

 
 

so that the discharge rate (volume flow), from Equation (2) becomes: 

 

 

 

 

 

 

The flow actually loses some energy between sections 1 and 2, and the velocity is not absolutely 
constant across either of these sections. As a result, the measured value of Q is always slightly less 

than the value calculated from theory - Equation (3). To allow for this, the equation becomes: 



 

 

 

 

 

 

where C is an adjustment factor called the coefficient of discharge for the meter, which you can find by 

experiment. Its value varies slightly from one meter to another and, even for a given meter it may vary 

slightly with the discharge, but is usually between 0.92 to 0.99 for a convergent-divergent (Venturi) 

meter. 

 

 

Finding the Coefficient of Discharge (C) 

Equation 4 can be re-arranged to give: 

 

 

 

 

 

As the dimensions of the Venturi (a1 and a2) and gravity (g) remain constant, the middle of the equation 
can simplify to a constant (k), so that: 

 

 

 

 

 

 
 

 

and therefore: 

 

 

 

 

 

Showing a linear relationship between flow, flow coefficient and the square root of head difference. 

 

Average Coefficient of Discharge 

From Equation 7, assuming C and k remain constant, a chart   h1 – h2 against Q (see Figure 
below) should produce linear results. You can then use the inverse gradient of the results to 
give an average value that you can substitute for the right hand side in Equation 7. 

 

 



2

 

 

 

 

 

 

 

 

 

 

 

 

Dimensionless Calculations of Pressure 
 
From Bernoulli’s equation the difference in head between any point and the inlet pressure may 

be found from: 

 

 
 

To easily compare actual results with theory, you must convert these terms into dimensionless 
calculations. To do this, dividing through by (u

2
 ⁄ 2g) gives: 

 

 

 

 

 

Using the equation of continuity (2) to substitute area ratios in place of 

velocity ratios, this becomes: 

 

 

 

 

 

Therefore, calculating the area ratios gives the theoretical or ‘ideal’ dimensionless pressure difference, 

otherwise known as ideal piezometric head coefficient: 

 

 

 

 

 

 



and the actual dimensionless pressure distribution (otherwise known as actual piezometric head 

coefficient) is found from: 

 

 

 

 

 

 

 

Equipments 

 
1. Venturi Meter (H5) 

2. Digital Hydraulic Bench (H1F) 

3. Two supply hoses 
 

Venturi Meter Description: 

 
Figure 2 shows the arrangement of the Venturi Meter. Water enters from a TecQuipment 

Hydraulic Bench (supplied separately) and passes through a flexible hose into the meter. A 

control valve downstream of the meter controls flow. After the control valve a further flexible 

hose leads to the central hole in the Digital Hydraulic Bench (H1F) or the measuring tank of 

existing Volumetric and Gravimetric Hydraulic Benches (H1D and H1). 

Tubes connect to pressure tappings along the Venturi wall. The tubes connect to vertical 

manometer tubes mounted in front of a scale for direct readings of pressure head difference in 

millimeters of water. The manometer tubes connect at their top ends to a common manifold that 

has a small air valve. the hand pump (supplied) allows the user to adjust the air pressure in the 

manifold and therefore uniformly adjust the water levels in the manometers, so they fit in the 

measuring range of the scale. 

 

A base with adjustable feet holds the whole assembly of Venturi Meter, manometer tubes, scale 

and manifold. 

Normally, when used for flow measurement, Venturi meters only use two tappings: one at the 

entrance and one at the throat. The Venturi Meter (H5) has more tappings to show the 

distribution of pressure along the length of the convergent-divergent passage. 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Procedure 

 
1. Put the apparatus on the top of a TecQuipment Hydraulic Bench (supplied separately). 

2. Connect the bench supply hose to the upstream (left) side of the Venturi meter. 

3. Connect the downstream end of the Venturi Meter to the plastic tube supplied and direct it back to 

the large central hole of the Digital Hydraulic Bench (H1F), or the measuring tank of the Volumetric 

(H1D) or Gravimetric (H1) Hydraulic Benches for flow measurement. 

4. Set both the apparatus flow control and bench supply valve to approximately one third fully open 

positions. 

5. Check that the air valve on the upper manifold is tightly closed. 

6. Switch on the bench supply and allow water to flow. To clear air from the manometer tubes it may 

help to slightly tilt the apparatus or lightly tap the tubes with your finger. 

7. Shut the apparatus flow control valve. Air will now be trapped in the upper parts of the manometer 

tubing and the manifold. 

8. Open the air valve just enough to allow water to rise approximately halfway up the manometer 

scale. 

9. Shut the air valve. 

10. Adjust both the bench supply and the apparatus control valves to give full flow. 

At this condition the maximum pressure difference between the Venturi inlet and throat should be 

about 240 mm. You may need to connect the pump to the air valve, and add some air to see all 

levels on the scale. 

11. Watch the water levels for a few moments to ensure the air valve is sealing properly. 

If the air valve leaks there will be a steady rise in the levels. 

If tightening the valve does not stop the leak, replace the seal in the valve. 

12. Now slightly reduce the flow rate through the meter, and wait for it to stabilize. Use the hydraulic 

bench to measure the flow. 

 

 

Figure 2: Venturi Meter 
 



13. Record the pressure tapping readings and the flow. Remember to convert your flow into volume 

flow of m3.s-1. 

 

14. Repeat for several more (lower) flow rates down to the minimum flow that gives you a reasonable 

set of pressure levels along the meter. 
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Experiment #8 

Flow Visualization 

 

Objectives 
• Recognize flow in different cases and its relation with human organ systems 

 

Theory 
In general, flow visualization is an experimental means of examining the flow pattern around a body or 

over its surface. The flow is "visualized" by introducing a dye to the flow in the area under 

investigation. The primary advantage of such a method is the ability to provide a description of a flow 

over a model without complicated data reduction and analysis. 

 There are three types of line patterns to visualize flow: 

1. Streamline: a line everywhere tangent to the velocity at a given instant. 

2. Path line: actual path traversed by a given fluid particle. 

3. Streak line: locus of particles which have earlier passed through a prescribed point. 

Under the steady flow condition, all the three types of line pattern are identical. An important 

distinction in single phase flow is whether the flow is laminar or turbulent or whether flow separates or 

secondary flows exist. This information helps in modeling specific phenomena because one has an 

indication of the flow character for a particular geometry. 

 

Several elements in flow visualization: 

• Reynolds Number: It is the ratio of inertia force to the viscous force acting in any flow phenomenon.  

Inertia force = mass X acceleration 

Viscous force = viscous shear stress X area of flow  
For open channel, Reynolds Number (Re) = ρVR/µ  

Where, V = avg. velocity of flow in channel, R = Hydraulic radius (ratio of area of flow to wetted 

parameter).  

Reynolds number is very useful in predicting whether the flow is laminar or turbulent and for finding out 

the coefficient of friction in order to determine the frictional loss of head accurately. 

  

• Laminar flow: When the fluid particle move in layers called lamina, then the flow is called laminar 

flow. Laminar flow occurs when velocity of flow is small and viscous forces are predominant. It is 

smooth and regular and thus also known as stream-line flow. There is practically no influence of fluid 

particles of one layer over those of the adjacent layer. Velocity at any point remains nearly constant in 

magnitude and direction. Flow through circular pipes with Reynolds number < 2000 is always laminar. 

In case of channel flow, if Reynolds number < 500, then the flow is laminar.  

• Turbulent flow: When the velocity of flow reaches a certain limit the fluid particles no longer move in 

layers or lamina. Violent mixing of fluid particles takes place due to which they move in chaotic and 

random manner. As a result the velocity at any point varies both in magnitude and direction from 

instant to instant. Such a flow is known as turbulent flow. Flow through circular pipes with Reynolds 

number > 4000 is turbulent. In case of channel flow, flow with Reynolds number > 2000 is turbulent. 

Steady and unsteady flow: If the condition of flow e.g. depth of flow, velocity etc. do not vary with 

respect to time, then the flow is said to be steady. Otherwise it is unsteady flow. 

• Stagnation point: point where streamline meat at the leading edge, velocity is zero. 

• Boundary layer: Region where velocity gradient at the surface of obstacle is zero and gradually 

increasing and ends when its velocity is constant. Heavily affected by viscous friction force. 

 



• Separation point: point where boundary layer separates far away from the surface of object. 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Hele-Shaw apparatus that will be used during this experiment produces streamlines in a laminar, 

steady flow. It allows students to study various source and sink arrangements, and look at flow around 

an unlimited variety of different shaped models. The apparatus can represent water seepage through 

solids and can simulate any process satisfying the Laplace equation in two dimensions. The apparatus 

works with a steady, air-free water supply and suitable drain. The equipment consists of a channel 

formed between two plates. Water flows along the channel at a low Reynolds number, so the inertia 

forces are not important. 

A dye flowing through several small holes at the upstream end produces streamlines. The removable 

top glass plate has grid-lines to help analysis of the flow patterns. The apparatus comes with a rubber 

sheet from which to cut out various shapes of models. When placed between the two plates, students 

can see the streamline patterns flowing around the models. Also, valves and a vacuum pump allow 

students to connect two sources and two sinks (or any combination of both). 
 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1: Elements in flow visualization 

Figure 2: The Hele-Shaw Apparatus  



The Momentum Equation 

Consider the equilibrium of the fluid contained within a volume ABCD. AB and CD are the cross-

sections of a stream tube.  

From Newton’s second law: 

 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3: The Momentum Equation 



 

 

 

 

 

 

 

 

The Laminar Flow Relationship for Flow between Two Parallel Plates 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

Figure 4: Flow between two parallel plates 



For steady laminar flow of liquid between two plates, a distance of 2zw apart: 

 

 

 

 

 

 

Mean Velocity Equations for Flow in the Apparatus and for Seepage in Soils 

 

Assuming the flow velocity through the apparatus is low enough for the inertia force to be 

negligible, from Equation (5): 

 

 

 

 

 

Equation (6) is satisfied for incompressible fluid flow through the Hele-Shaw apparatus, in 

which case we may write: 

 

 

 

 



If x denotes distance in the direction of the free stream and y denotes the distance at right angles 

in a plane parallel with the walls, 

 

 

 

 

 

 

 

 

 
But Vx and Vy are functions of x and y and in exactly the same way as that outlined in Equation (9), by the 

principle of continuity: 

 

 

Materials and Methods 
• Hele-Shaw apparatus 

• Dye 

• Header Tank 

Procedure 

Exercise #1: Source in a Uniform Stream 

 

 
 
 
 
 
 
 

 

 

 

 

1. Set the relevant three-way valve to supply water to one of the sink/source points. 

 

2. Start the water supply and open the dye bottle tap just enough to produce easily visible streamlines. 

 

3. Fit and use the transfusion clamps (supplied) to adjust either the source supply or the free stream 

supply. This will adjust the strength of the source relative to the free stream. 

 

4. You should see a streamline pattern with flow around the dividing streamline as shown in Figure 5. 

 

Exercise #2: Sink in a Uniform Stream 

1. Set the relevant three-way valve to allow water to flow from one of the sink/source points to drain. 

2. Start the water supply and open the dye bottle tap just enough to produce easily visible streamlines. 

3. Fit and use the transfusion clamps (supplied) to adjust the flows. If necessary, use the vacuum pump 

(supplied) to increase the sink flow. 

Figure 5: Source in a uniform stream 



 

 

 

 

 

 

 

 

 

 

 

 

 

 Exercise #3: Flow Through a Diffuser 

To make this work, cut two identical shapes (see Figure 7) from the sheet. Put them in the 

middle of the flow channel as shown in Figure 7. This forms a diffuser or nozzle. Block the flow 

to or from the source and sink points (using the clamps where necessary). The dye should flow 

in thin streams through the nozzle to the drain header. This should give an indication of the flow 

contraction and expansion around the nozzle. 

 

 
 

 

 

 

 

 
 

Flow 

Figure 7: Flow through a diffuser 

Figure 6: Sink in a uniform stream 


